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1 Introduction  

This document provides an introduction to Postgres Enterprise ManagerÊ (PEM).  The 

guide will acquaint you with the basics of the toolset, and help you be successful in your 

database management activities.  The guide is broken up into the following core sections 

and categories:  

¶ Postgres Enterprise Manager Overview ï Chapter 2 provides information about 

PEM functionality, components, architecture, and supported platforms. 

¶ Using the PEM Web Interface ï Chapter 3 provides an overview of PEM's web 

interface.  The web interface is installed with the PEM server, and can be used 

from your browser of choice.  

¶ Registering a Server - Chapter 4 highlights the different tools available to assist 

with server registration. 

¶ General database administration ï Chapter 5 will assist you in performing 

general database administration tasks, and SQL query and stored procedure 

development.  

¶ Server Management - Chapter 6 provides information about controlling the PEM 

server, and managing server authentication. 

¶ PEM Agent Management - Chapter 7 provides information about configuring 

and managing a PEM agent. 

¶ Replacing SSL Certificates - Chapter 8 provides information about managing 

SSL certificates. 

This guide is not a comprehensive resource; rather, it is meant to serve as an aid to bring 

you up to speed with the basics of how to use the product.  For more information about 

using PEM features, please see the online help made available through the PEM web 

interface, or in the PEM guides.  

This document uses Postgres to mean either the PostgreSQL or EDB Postgres Advanced 

Server database.   
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1.1 What's New   

The following features have been added to PEM 7.7 for this release:  

¶ The PEM interface features an updated user-friendly look and feel. 

¶ The Query Tool now features a scratch pad, where you can save text snippets 

while working. 

¶ The Query Tool now features COMMIT and ROLLBACK buttons. 

¶ You can use the X- FRAME- OPTIONS setting to manage page rendering and 

prevent clickjacking; the default is SAMEORIGIN.   

¶ Child node behavior in the tree control is updated to auto-expand if a single entry 

is present. 
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1.2 Typographical Conventions Used in this Guide  

Certain typographical conventions are used in this manual to clarify the meaning and 

usage of various commands, statements, programs, examples, etc. This section provides a 

summary of these conventions. 

In the following descriptions a term refers to any word or group of words that are 

language keywords, user-supplied values, literals, etc. A termôs exact meaning depends 

upon the context in which it is used. 

¶ Italic font introduces a new term, typically, in the sentence that defines it for the 

first time. 

¶ Fixed - width (mono - spaced) font  is used for terms that must be given 

literally such as SQL commands, specific table and column names used in the 

examples, programming language keywords, etc. For example, SELECT * FROM 

emp;  

¶ Italic fixed - width font  is used for terms for which the user must 

substitute values in actual usage. For example, DELETE FROM table_name ; 

¶ A vertical pipe | denotes a choice between the terms on either side of the pipe. A 

vertical pipe is used to separate two or more alternative terms within square 

brackets (optional choices) or braces (one mandatory choice). 

¶ Square brackets [ ] denote that one or none of the enclosed term(s) may be 

substituted. For example, [ a | b ] , means choose one of ñaò or ñbò or neither 

of the two. 

¶ Braces {} denote that exactly one of the enclosed alternatives must be specified. 

For example, { a | b } , means exactly one of ñaò or ñbò must be specified. 

¶ Ellipses ... denote that the proceeding term may be repeated. For example, [ a | 

b ] ...  means that you may have the sequence, ñb a a b a ò. 
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2 Postgres Enterprise Manager - 
Overview  

Postgres Enterprise Manager (PEM) is an enterprise management tool designed to assist 

database administrators, system architects, and performance analysts in administering, 

monitoring, and tuning PostgreSQL and EnterpriseDB Advanced Server database servers.  

PEM is architected to manage and monitor anywhere from a handful, to hundreds of 

servers from a single console, allowing complete and remote control over all aspects of 

your databases.  

2.1 Why Postgres Enterprise Manager?  

PEM provides a number of benefits not found in any other PostgreSQL management tool: 

¶ Management en Masse Design. PEM is designed for enterprise database 

management, and is built to tackle the management of large numbers of servers 

across geographical boundaries.  Global dashboards keep you up to date on the 

up/down/performance status of all your servers in an at-a-glance fashion. 

¶ Distributed Architecture . PEM is architected in a way that maximizes its ability 

to gather statistical information and to perform operations remotely on machines 

regardless of operating system platform. 

¶ Graphical Administration . All aspects of database administration can be carried 

out in the PEM client via a graphical interface.  Server startup and shutdown, 

configuration management, storage and security control, object creation, 

performance management, and more can be handled from a single console. 

¶ Full SQL IDE . PEM contains a robust SQL integrated development environment 

(IDE) that provides ad-hoc SQL querying, stored procedure/function 

development, and a graphical debugger. 

¶ Enterprise Performance Monitoring. PEM provides enterprise-class 

performance monitoring for all managed database servers. Lightweight and 

efficient agents monitor all aspects of each database serverôs operations as well as 

each machineôs underlying operating system and provide detailed statistics back 

to easily navigated performance pages within the interface. 

¶ Proactive Alert Management. PEM ships out-of-the-box with the ability to 

create performance thresholds for each key metric (e.g. memory, storage, etc.) 

that are monitored around-the-clock. Any threshold violation results in an alert 

being sent to a centralized dashboard that communicates the nature of the problem 
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and what actions are necessary to prevent the situation from jeopardizing the 

overall performance of the server. 

¶ Simplified Capacity Planning. All key performance-related statistics are 

automatically collected and retained for a specified period of time in PEMôs 

repository. The Capacity Manager utility allows you to select various statistics 

and perform trend analysis over time to understand things such as peak load 

periods, storage consumption trends, and much more. A forecasting mechanism in 

the tool allows you to also forecast resource usage in the future and plan/budget 

accordingly. 

¶ Audit Manager. The Audit Manager configures audit logging on Advanced 

Server instances. Activities such as connections to a database, disconnections 

from a database, and the SQL statements run against a database can be logged. 

The Audit Log  dashboard can then be used to filter and view the log. 

¶ Log Manager. The Log Manager wizard configures server logging parameters, 

with (optional) log collection into a central table.  Use the wizard to specify your 

preference for logging behaviors such as log file rotation, log destination and 

error message severity.  Use the Server  Log  dashboard to filter and review the 

collected server log entries. 

¶ SQL Workload Profiling . PEM contains a SQL profiling utility that allows you 

to trace the SQL statements that are executed against one or more servers. SQL 

profiling can either be done in an ad-hoc or scheduled manner. Captured SQL 

statements can then be filtered so you can easily identify and tune poorly running 

SQL statements. SQL statements can also be fed into an Index Advisor on 

Advanced Server that analyzes each statement and makes recommendations on 

new indexes that should be created to help performance. 

¶ Expert Database Analysis. PEM includes the Postgres Expert utility. Postgres 

Expert analyzes selected databases for best practice enforcement purposes. Areas 

such as general configuration, security setup, and much more are examined. Any 

deviations from recommended best practices are reported back to you, along with 

an explanation of each particular issue, and expert help on what to do about 

making things right. 

¶ Streaming Replication Configuration and Monitoring.   The Streaming 

Replication wizard simplifies the process of adding new servers to a Postgres 

streaming replication scenario or configuring existing servers to create a 

replication scenario.  After configuring the replication scenario, you can monitor 

the scenario on the Streaming Replication dashboard or use options on the PEM 

client to promote a standby node to the master node. 

¶  Secure Client Connectivity. PEM supports secure client connections through an 

encrypted SSH tunnel.  The full-featured PEM client includes an SSH Tunnel 
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definition dialog that allows you to provide connection information for a secure 

connection. 

¶ Wide Platform Support. PEM supports most major Linux and Windows 

platforms. 
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2.2 General Architecture  

PEM is composed of three primary components (see Figure 2.1): 

The PEM Server 

The PEM server provides the functionality at the core of Postgres Enterprise 

Manager.  The server is responsible for: 

¶ Performing administrative functions. 

¶ Processing information received from agents.  

¶ Maintaining information in its repository. 

The PEM Agent 

The PEM agent is responsible for performing tasks on each managed machine and 

collecting statistics for the database server and operating system. 

The PEM Web Interface 

Distributed with the PEM server, the PEM web interface allows you to connect to 

the server with your choice of browser to manage and monitor your Postgres 

servers.  

 

Figure 2.1 - The Postgres Enterprise Manager general architecture. 
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2.3 Supported Versions and Platforms   

The PEM server and agent use Advanced Server or PostgreSQL backing databases 

(version 9.3 and higher).  PEM can manage and monitor Advanced Server and 

PostgreSQL database versions 9.3 and higher. 

The PEM server and agent are supported on:  

64-bit Linux: 

¶ CentOS 6.x and 7.x 

¶ Red Hat Enterprise Linux 6.x and 7.x 

¶ OEL 6.x and 7.x 

¶ Ubuntu 16.04 LTS and 14.04 LTS 

¶ Debian 7.x and 8.x 

¶ SLES 12 

64-bit Windows: 

¶ Windows Server 2016 

¶ Windows Server 2012 R2 

The PEM agent is also supported on Linux ppc64le using RHEL / CentOS 7.x as a PEM 

server host. 

RPM packages for the PEM agent are available for RHEL 6.x and 7.x. 

The PEM client is supported on the following browsers: 

¶ Google Chrome 

¶ Mozilla Firefox 

¶ Internet Explorer 

¶ Apple Safari 

SQL Profiler is supported on Advanced Server and EnterpriseDB distributions of 

PostgreSQL version 9.3 and above. 
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2.4 Installing PEM - Overview  

For detailed instructions about installing PEM, please consult the PEM Installation 

Guide, available at: 

http://enterprisedb.com/products-services-training/products/documentation 

The basic steps involved in the PEM installation process are: 

1. Install the PEM server components.  The PEM server software and backend 

database (named pem) may reside on the same host as the supporting httpd server, 

or may reside on a separate host.   

The PEM server installer installs a PEM agent and the PEM client on the host of 

the PEM server. 

2. Register each additional physical or virtual machine that you would like to 

manage with PEM.  For convenience, PEM 7 supports remote monitoring (an 

agent is not required to reside on the same host as the server that it monitors).   

Please note that a remote agent cannot retrieve all of the information available 

from a monitored server; you may wish to install an agent on each server host.   

3. Install the SQL Profiler component into each Postgres instance on which you 

want to perform SQL capture and analysis.  The SQL Profiler installer will 

prompt you for the location of your Postgres installation, and place the required 

software into that directory.  The SQL Profiler plugin is already installed on 

Advanced Server instances, and requires only configuration to enable profiling. 

 

 

http://enterprisedb.com/products-services-training/products/documentation
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3 Using the  PEM Web Interface  

The PEM web interface is installed with the PEM server.  When the server installation 

completes, you can open the PEM interface in your choice of browser by navigating to: 

https:// ip_address_of_PEM_host :8443 /pem  

Where ip_address_of_PEM_host  specifies the IP address of the host of the PEM 

server.  The Postgres  Enterprise  Manager  Login  window (shown in Figure 3.1) 

opens: 

 

Figure 3.1 - The PEM Login page. 

Use the fields on the Postgres  Enterprise  Manager  Login  window to authenticate 

yourself with the PEM server: 

¶ Provide the name of a pem database user in the Username  field.  For the first user 

connecting, this will be the name provided when installing the PEM server. 

¶ Provide the password associated with the user in the Password  field. 

After providing your credentials, click Login  to connect to PEM.   

The PEM web interface opens, displaying the Global  Overview  Dashboard  

(seeFigure 3.2). 
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Figure 3.2 - The Global Overview dashboard, displayed in the client. 

The Browser  pane displays a tree control that provides access to information about the 

database objects that reside on each server.  The tree control expands to display a 

hierarchical view of the servers and objects that are monitored by the PEM server.   

The PEM menu bar provides access to commands and features that you can use to 

manage your database servers and the objects that reside on those servers.  If an option is 

disabled: 

¶ The database server to which you are currently connected may not support the 

selected feature. 

¶ The selected menu option may not be valid for the current object (by design). 

¶ The role that you have used to connect to the server may have insufficient 

privileges to change the selected object. 

 

 

 

 

 



EDB Postgres Enterprise Manager Getting Started Guide 

Copyright © 2013 - 2019 EnterpriseDB Corporation.  All rights reserved. 
 

16 

3.1 The PEM Toolbar  

Context-sensitive menus across the top of the PEM web interface allow you to customize 

your environment and provide access to the enterprise management features of PEM. 

The File Menu 

 

Figure 3.3 ï The File Menu 

Use the File  menu (see Figure 3.3) to access the following options: 

Menu Option  Action  
Preferences   Click to open the Preferences dialog to customize your PEM client 

settings. 
Reset Layout   If you have modified the workspace, click to restore the default layout.           

 

The Object Menu 

 

Figure 3.4 ï The Object Menu. 

The Object  menu (see Figure 3.4) is context-sensitive.  Use the Object  menu to access 

the following options: 
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Menu Option  Action  
Connect Server...   Click to open the Connect to Server dialog to establish a connection with a server. 
Create   Click *Create* to access a context menu that provides context-sensitive selections. 
CREATE Script   Click to open the Query tool to edit or view the selected script.  
Delete/Drop   Click to delete the currently selected object from the server. 
Disconnect Serveré  Click to refresh the currently selected object. 
Drop Cascade   Click to delete the currently selected object and all dependent objects from the 

server. 
Hideé  Click to hide the currently selected group; to view hidden groups, enable the Show 

hidden  groups  option in Preferences . 
Properties ...   Click to review or modify the currently selected object's properties. 
Refresh...   Click to refresh the currently selected object.    
Trigger(s)   Click to *Disable* or *Enable* trigger(s) for the currently selected table. 
Truncate   Click to remove all rows from a table (Truncate) or to remove all rows from a 

table and its child tables (Truncate Cascade). 
View Data   Click to access a context menu that provides several options for viewing data. 

 

The Management Menu 

 

Figure 3.5 ï The Management Menu. 
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Use the Management  menu (see Figure 3.5) to access the following PEM features:  

Menu Option  Action  
Audit Manager...                  Click to open the Audit Manager and configure auditing on your monitored 

servers.             
Auto Discovery...                 Click to open the Auto Discovery dialog to instruct a PEM agent to locate and bind 

monitored database servers. 
Capacity Manager...            Click to open the Capacity Manager dialog and analyze historical or project future 

resource usage. 
Log Manager. ..           Click to open the Log Manager dialog and configure log collection for a server. 
Manage Alerts...        Click to access the Manage Alerts tab and create or modify alerting behavior. 
Manage Charts...   Click to open the Manage Charts tab to create or modify PEM charts. 
Manage Dashboards...        Click to open the Manage Dashboards dialog to VACUUM, ANALYZE, REINDEX, or 

CLUSTER. 
Manage Probes...   Click to open the Manage Probes  dialog to VACUUM, ANALYZE, REINDEX, or 

CLUSTER. 
Package Deployment...      Click to open the Package Deployment wizard and install or update packages. 
Postgres Expert...   Click to open the Postgres Expert wizard and perform a static analysis of your 

servers and databases.  
Postgres Log Analysis 

Expert...  
 Click to access the Postgres Log Analysis Expert dialog analyze log file contents for 
usage trends.            

Queue Server Startupé   Click to instruct the PEM server to start the currently selected server. 
Queue Server Shutdown       Click to instruct the PEM server to shut down the currently selected server.        
Replace Cluster Master      Click to replace the current master node of your replication scenario.      
Scheduled Tasks          Click to open the Scheduled Tasks tab and review tasks that are pending or 

recently completed. 
Server 

Configuration...      
 Click to open the Server Configuration dialog and update your PEM server 
configuration settings. 

SQL Profiler...   Click to open the SQL Profiler dialog to capture statistical information about SQL 
query performance.          

Streaming 

Replication...   
 Click to access the Streaming Replication dialog configure a streaming replication 
scenario.                     

Tuning Wizard...   Click to open the Tuning Wizard dialog to generate a set of tuning 
recommendations for your server.    

The Dashboards Menu 

 

Figure 3.6 ï The Dashboards menu. 
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Use the context-sensitive Dashboards  menu (see Figure 3.6) to access dashboards:  

Option   Action  
Alerts Dashboard   Click to open the Alerts Dashboard for the selected node. 
Audit Log Analysis   Click to open the Audit Log Analysis Dashboard for the selected 

node 
Database Analysis   Click to open the Database Analysis Dashboard for the selected 

node. 
I/O Analysis   Click to open the I/O Analysis Dashboard for the selected node. 
Memory Analysis   Click to open the Memory Analysis Dashboard for the selected 

node 
Object Activity Analys is   Click to open the Object Activity Analysis Dashboard for the 

selected node. 
Operating System Analysis   Click to open the Operating System Analysis Dashboard for the 

selected node. 
Probe Log Analysis   Click to open the Probe Log Analysis Dashboard for the selected 

node. 
Server Analysis   Click to open the Server Analysis Dashboard for the selected node. 
Server Log Analysis   Click to open the Server Log Analysis Dashboard for the selected 

node. 
Sessio n Activity Analysis   Click to open the Session Activity Analysis Dashboard for the 

selected node. 
Storage Analysis   Click to open the Storage Analysis Dashboard for the selected 

node. 
Streaming Replication 

Analysis  
 Click to open the Streaming Replication Analysis Dashboard for 
the selected node. 

System Wait Analysis   Click to open the System Wait Analysis Dashboard for the selected 
node. 

 

The Tools Menu 

 

Figure 3.7 ï The Tools menu. 

Use the options on the Tools  menu (see Figure 3.7) to access the following features:  
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Option     Action    
Add named restore point   Click to open the dialog to take a point-in-time snapshot of the current 

server state. 
Backup...   #ÌÉÃË ÔÏ ÏÐÅÎ ÔÈÅ "ÁÃËÕÐȣ ÄÉÁÌÏÇ ÔÏ ÂÁÃËÕÐ ÄÁÔÁÂÁÓÅ ÏÂÊÅÃÔÓȢ    
Backup Globals...   #ÌÉÃË ÔÏ ÏÐÅÎ ÔÈÅ "ÁÃËÕÐ 'ÌÏÂÁÌÓȣ ÄÉÁÌÏÇ ÔÏ ÂÁÃËÕÐ ÃÌÕÓÔÅÒ ÏÂÊÅÃÔÓȢ     
Backup Server...   #ÌÉÃË ÔÏ ÏÐÅÎ ÔÈÅ "ÁÃËÕÐ 3ÅÒÖÅÒȣ ÄÉÁÌÏÇ ÔÏ ÂÁÃËÕÐ Á ÓÅÒÖÅÒȢ        
Grant Wizard...   Click to access the Grant Wizard tool.     
Import/Export...   Click to open the Import/Export data...  dialog to import or export data 

from a table.   
Maintenance...   #ÌÉÃË ÔÏ ÏÐÅÎ ÔÈÅ -ÁÉÎÔÅÎÁÎÃÅȣ ÄÉÁÌÏÇ ÔÏ 6!#55-ȟ !.!,9:%ȟ 

REINDEX, or CLUSTER. 
Pause replay of WAL   Click to pause the replay of the WAL log. 
Query tool   Click to open the Query tool for the currently selected object.  
Reload Configuration...   Click to update configuration files without restarting the server. 
Restore...   Click to access the Restore dialog to restore database files from a 

backup.  
Resume replay of WAL   Click to resume the replay of the WAL log.  

 

The Help Menu 

 

Figure 3.8 ï The Help menu. 

Use the options on the Help  menu (see Figure 3.8) to access online help documents or to 

review information about the PEM installation: 

Option   Action  
Online Help   Click to open documentation for Postres Enterprise Manager. 
EnterpriseDB  Website   Click to open the EnterpriseDB website in a browser window. 
About Postgres Enterprise 

Manager  
 Click to locate versioning and user information for Postgres 
Enterprise Manager. 
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3.2 Controlling and Customizing Charts, Graphs and Tables  

Use the icons in the upper-right corner of each graphic on a dashboard to control and 

customize the charts, graphs and tables displayed in the PEM client for your current user 

session (see Figure 3.9). 

 

Figure 3.9 ï The PEM Client chart control icons. 

Select an icon to: 

 

  Refresh the content of a chart, graph or table. 

 

  Download an image of the chart or graph. 

 

  Expand the chart or graph to full-screen. 

 

  Personalize the chart, graph, or table settings for the current user. 

 

  View information about the chart, graph, or table. 

For more information about customizing the graphics displayed on the PEM dashboards, 

please see the PEM client online help. 
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4 Managing a Monitore d Server  

Before you can manage or monitor a server with PEM, you must register the server with 

PEM, and bind an agent.  A server may be bound to a remote agent (an agent that resides 

on a different host), but if the agent does not reside on the same host, it will not have 

access to all of the statistical information about the instance. 

 

4.1 Manually Registering a Server  

To manage or monitor a server with PEM, you must:  

¶ register your Advanced Server or PostgreSQL server with the PEM server. 

¶ bind the server to a PEM agent.   

You can use the Create -  Server  dialog to provide registration information for a 

server, bind a PEM agent, and display the server in PEM client tree control.  To open the 

Create -  Server  dialog, navigate through the Create  option on the Object  menu 

(or the context menu of a server group) and select Serveré (see Figure 4.1). 

 

Figure 4.1 ï Accessing the Create ï Server dialog. 

Please note: you must ensure the pg_hba.conf  file of the Postgres server that you are 

registering allows connections from the host of the PEM client before attempting to 

connect.   








































































































